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About VBrick Systems

Founded in 1997, VBrick Systems, an ISO 9001 certified vendor, is a privately held company that has enjoyed rapid growth 
by helping our customers successfully introduce mission critical video applications across their enterprise networks. Since our 
founding, VBrick has been setting the standard for quality, performance and innovation in the delivery of live and stored 
video over IP networks—LANs, WANs and the Internet. With thousands of video appliances installed world-wide, VBrick is 
the recognized leader in reliable, high-performance, easy-to-use networked video solutions.

VBrick is an active participant in the development of industry standards and continues to play an influential role in the 
Internet Streaming Media Alliance (ISMA), the MPEG Industry Forum, and Internet2. In 1998 VBrick invented and shipped 
the world's first MPEG Video Network Appliance designed to provide affordable DVD-quality video across the network. 
Since then, VBrick's video solutions have grown to include Video on Demand, Management, Security and Access Control, 
Scheduling, and Rich Media Integration. VBrick solutions are successfully supporting a broad variety of applications 
including distance learning and training, conferencing and remote office communications, security, process monitoring, 
traffic monitoring, business and news feeds to the desktop, webcasting, corporate communications, collaboration, command 
and control, and telemedicine. VBrick serves customers in education, government, healthcare, and financial services markets 
among others. 

http://www.vbrick.com/opensource


Rich Media Studio Admin Guide iii

Contents

Rich Media Studio v1.7.27 Admin Guide
Preface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . vii

Organization . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . vii
Getting Help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . viii
Font Conventions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . viii

Environmental Goals . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . viii

1.  Introduction

Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1
Recommended Workflow  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1

How It Works. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4
Using the VBrick Template . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
Playing a Rich Media Stream . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

Rich Media Studio Versions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

2.  Hardware Installation

What's in the Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
Safety Precautions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8

Power. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
Electrostatic Discharge . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
Placement  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
Anti-Virus Software  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

RMS Standard Edition/Professional Edition  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
A/V Adapter Cable . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10
VGA Input and Output. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
Connecting a Video Camera . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
Power and Network Connections . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
Audio Connections . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
Mouse and Keyboard  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

RMS High Definition . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
A/V Adapter Cable . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
VGA/DVI (RGB) Input . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
HD SDI Input . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
DVI/HDMI Display Output. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
Audio Connections . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
Mouse and Keyboard  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

RMS High Definition (Portable)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
A/V Adapter Cable . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
VGA/DVI (RGB) Inputs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17



iv Contents

HD SDI Input . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
VGA/DVI Display Outputs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
Audio Connections . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
Mouse and Keyboard  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18

Starting Rich Media Studio . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
Checking the Version Number  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20

Defining Audio and Video Inputs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
Defining the Camera Input Sources . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

3.  Configuring Outputs

Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23
Best Practices  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24

Using the Template  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
Modifying the Template  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27

Configuring Windows Media Outputs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
Configuring for Pull  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28
Configuring for Push. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29
Configuring for Silverlight. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30
Configuring for Multicast . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
Configuring for VEMS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
Configuring for VBOSS  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31

Configuring H.264 Outputs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
Configuring for VEMS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
Configuring for DME . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34

4.  Delivering a Presentation

Touch Session Basics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37
Using the Presets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38

Delivering a Touch Presentation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39
Using RMS with VEMS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42

5.  Using Session Studio/Builder

Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43
Tools  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44

Hardware Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45
Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45

Launching a Session . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
Session Properties . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49

Creating a Mix . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54
Creating an Output . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55
Adjusting Settings and Mix Templates  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57
Events . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59
Scheduler . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61

Changing the Language . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 62
Saving a Session . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63



Rich Media Studio Admin Guide v

6.  Viewing Rich Media Streams

Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65
Viewing Live Streams. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65

Viewing Live Streams from RMS  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65
Viewing Live Streams from VEMS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65

Viewing Stored Streams . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66
Viewing Stored Streams from a Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66
Viewing Stored Streams from VEMS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66

7.  Maintenance and Upgrade

System Maintenance. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67
Installing Windows Updates . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67
Managing Disk Space  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67

Backup and Restore . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67
Software Upgrade. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68

Upgrading from RMS 1.0/1.2/1.3 to 1.7.27 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68

8.  Using 3M MicroTouch

MicroTouch Software Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71
MicroTouch Control Panel. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71

Calibration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72
Touch Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73

Touchdown Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73
Liftoff Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74
Right-Click Tool . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74
Touch Sound . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74
Double-Click Speed  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74
Double-Click Area  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74

Edge Adjustment Tab  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75
Troubleshooting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75

9.  Streaming to the DME

Streaming to the DME with RTP Auto-Unicast  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77
Streaming to the DME with RTMP Push  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 79



vi Contents



Rich Media Studio Admin Guide vii

Rich Media Studio v1.7.27 Admin
Guide

Preface
This document is written for anyone using or evaluating VBrick's Rich Media Studio. The 
Rich Media Studio is a powerful presentation recording appliance that will enhance the 
effectiveness and reach of any educational, corporate, or public event communication by 
capturing and streaming real-time rich media presentations with DVD quality video and high 
fidelity sound. Rich Media Studio is ideal for use by educational institutions, training 
organizations, seminar and event organizers, as well as by enterprises. Organizations can 
deploy Rich Media Studio in meeting and conference rooms or bring it to off-site events to 
record and stream live and on demand executive briefings, training sessions, product 
demonstrations, global announcements, marketing communications, and more. Rich Media 
Studio accepts and synchronizes feeds from any A/V equipment available, including 
microphones, cameras, VCR/DVD players, document cameras, and other video conferencing 
equipment. The appliance can capture a computer screen output as a video stream, allowing 
the presenter to demonstrate any application on their computer. 

Organization

1. Introduction provides an overview of the Rich Media Studio 
application and a brief description of how it works.

2. Hardware Installation explains how to install the hardware including all cables 
and connectors and how to define audio and video 
inputs. 

3. Configuring Outputs describes the preconfigured template. It explains how to 
create your own template. and how to configure for push, 
pull, multicast, etc. 

4. Delivering a Presentation explains how advanced users can use the Rich Media 
Studio application to create and deliver customized rich 
media presentations. 

5. Using Session Studio/Builder describes how to use Studio Touch application to quickly 
and easily deliver presentations using the preconfigured 
templates. 

6. Viewing Rich Media Streams explains how to view live and stored Rich Media Studio 
streams.

7. Maintenance and Upgrade describes common maintenance tasks and explains how 
to backup and restore the application.

8. Using 3M MicroTouch explains how to use proprietary touch screen software on 
RMS High Definition (Portable) systems only.

9. Streaming to the DME explains how to configure streams being sent to VBrick's 
Distributed Media Engine (DME). 



viii Preface

Getting Help

If you can't find the information you need in this document, or from your reseller, you can 
contact VBrick Support Services on the web, by e-mail, or by calling 1-203 303-0222. For 
faster service, be sure to have your VBrick product serial number or support contract 
number. Support Services can usually answer your technical questions in 24 business hours or 
less. Note that all VBrick documentation is on the web. For more information about any 
VBrick product, go to www.vbrick.com/documentation 

Font Conventions

Arial bold is used to describe dialog boxes and menu choices, for example: Start > All 
Programs > VBrick

Courier fixed-width font is used for scripts, code examples, or keyboard commands.

Courier bold fixed-width font is used for user input in scripts, code examples, or keyboard 
commands. 

This bold black font is used to strongly emphasise important words or phrases. 

Folder names and user examples in text are displayed in this sans serif font. 

User input in text is displayed in this bold sans serif font. 

Italics are used in text to emphasize specific words or phrases.

Environmental Goals 
At VBrick, we believe that running our company with a "green" conscience is good for the 
environment and good for business and that environmental awareness is an important part of 
the value we deliver to our customers. We recognize our responsibilities to our customers, 
partners, and employees, and also to the communities in which we live and work. We believe 
that the same ethics and principles that guide our daily business decisions should be applied 
to the environment as well. We design superior quality, high performance, and energy-
efficient products and are continually looking for  ways to conserve energy and reduce waste. 
As a company, we look for ways to be environmentally friendly in designing our products and 
operating our facilities, and by choosing partners and suppliers who are committed to 
sustainable development. You can help by recycling batteries and other consumables and by 
finding new and better ways to protect and preserve our environment. If you have ideas or 
suggestions that will help to reinforce our commitment to these goals, please let us know. 

http://www.vbrick.com/support/index.asp
mailto:support@vbrick.com
http://www.vbrick.com/documentation/index.html
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Overview
VBrick's Rich Media Studio allows organizations to easily deliver live rich media 
presentations over IP networks and record them for on-demand viewing. It combines video 
and VGA/DVI capture into one video stream that seamlessly works with VBrick EtherneTV, 
VBrick reflectors, Windows Media servers, and VBrick's Online Streaming Service (VBoss). 
Rich Media Studio is the industry's most versatile, scalable, and easy-to-manage solution. 
Rich Media Studio is the only solution that combines video inputs and VGA/DVI inputs into 
one video stream. It scales enterprise-wide when used with VBrick reflector appliances and 
also allows playback on a set top box. It streams desktop capture at native resolution (up to 
1024x768) and avoids the common problem of having to manage hundreds of .jpg snapshots. 
It also provides picture-in-picture so that streams can be delivered to mobile devices. 

Recommended Workflow

The recommended workflow, at a location with multiple RMS units, consists of the following 
steps. These steps are typically performed by a qualified IT worker who will be configuring 
the outputs and by an educator or other presenter who will actually be giving the 
presentation.

               

Figure 1.  RMS Standard Figure 2.  RMS High Definition

Note RMS Standard and RMS Professional use the default.session template. RMS High 
Definition and RMS High Definition Portable use the defaultHD.session template. 
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 To setup, configure, and launch an RMS presentation:

1. An IT worker will unpack, inspect, and set up the unit, and connect it to your network.
2. Using the appropriate session template, an IT worker will configure the output streams 

for each RMS unit at your site using the following steps:
a. In RMS Studio/Builder , go to File > Load Session and open default.session or 

defaultHD.session.
b. Open Session Properties and configure Windows Media, Silverlight, H.264, or High 

Definition outputs as appropriate. Click OK on each page.
c. When done, go to File > Save Session As and save the session file with a new name, 

for example my_session.session. 
d. Repeat these steps for each RMS unit at your site. 

3. An educator or other presenter will actually launch and stream a presentations using 
these steps:
a. In RMS Touch, click the session file you created above (for example: my_session). 

This will launch the Touch interface for this session. 
b. Click the Record button to begin streaming the presentation. 
c. Deliver your presentation and click on the various presets to change the appearance 

of the stream. 
d. Click on the Record button again when done. This will stop the stream and archive 

the recording for future use (if archiving is configured).

Table 1.  RMS Features and Benefits

Table 2.  Hardware Specification: RMS Standard Edition/RMS Professional Edition

Feature Benefit

Multiple audio and video 
inputs

• Lets the presenter switch between a variety of inputs to 
create dynamic presentations.

• Examples include cameras, VGA/DVI output from a 
computer, document camera, DVD, etc.

Output is one video stream • Seamless integration with VEMS (VBrick Enterprise media 
System). 

• Seamless integration with VBrick reflectors. 
• Seamless integration with VBoss (VBrick Online Streaming 

Services. 
• Displays stream on set top boxes.
• Easy file management 

Preconfigured templates Allows out-of-box integration with VEMS.

Touch screen interface to 
easily switch inputs

• Creates engaging presentations. 
• No technical skills required. Presentation can be run by 

anyone with limited computer skills.

Easy-to-use presets Presenter can change inputs with one click.

Video Input † Standard 1 S-Video or Composite
1 VGA, analog, D-Sub (female) or DVI-I, analog/digital

Professional 1 VGA, analog, D-Sub (female) or DVI-I, analog/digital
• 2 S-Video
• 4 Composite video via RCA
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Table 3.  Hardware Specifications: RMS High Definition/High Definition (Portable)

Video Output • 1 DVI
• 1 VGA
• 1 HDMI

Audio Input Standard • 1 balanced with preamplifier and Phantom Power for 
microphone via XLR connectors

• 1 stereo balanced with attenuator via 2 XLR connectors

Professional • 1 balanced with preamplifier and Phantom Power for 
microphone via XLR connectors

• 2 stereo unbalanced via RCA connectors
• 1 stereo balanced with attenuator via 2 XLR connectors

Audio Output • Not enabled on Standard. 
• 1 Stereo balanced via 2 XLR connectors

Connectivity Front: • 1 USB 2.0
• 1 eSATA & USB combo port
• 1 MMC/SD/MS Flash Card Reader

Back • 8 USB 2.0
• 1 eSATA
• 1 eSATA Power

Storage 500 GB 

Optical 
Drive

22X DVD/CD R/RW

Dimensions W x L x H = 8 in. x 13.1 in x 8.5 in (204mm x 333mm x 215mm)

Weight 25 lbs (11kg)

Power 500W Input: 100-240V AC

†  1600x1200 RGB input is allowed but not recommended. The output will be cropped and the 
viewing experience will be less than ideal. The maximum recommended RGB input resolutions for 
full frame rate capture (30fps) are 1024x768 (4:3) and 1280x720 (16:9).

RMS High Definition RMS High Definition (Portable)

Video Input • Analog RGB & DVI
• 2 S-Video
• 4 Composite video via RCA
• 1 to 4 Digital (HD-SDI)

Recommended input resolutions 
for full frame rate (30fps) are 
1024x768 (4:3) or 1280x720 (16:9)

• Analog RGB & DVI
• 2 S-Video
• 4 Composite video via RCA
• 1 to 4 Digital (HD-SDI)

Recommended input resolutions for full 
frame rate (30fps) are 1024x768 (4:3) or 
1280x720 (16:9)

Video 
Output

• 1 HDMI
• 1 DVI (VGA With adapter)

• 1 HDMI
• 1 DVI
• 1 VGA, 
• 1 Display Port
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How It Works
Rich Media Studio is an "all-in-one" device that captures and delivers live presentations and 
records them for on-demand playback over IP networks. This device has the power and 
functionality to easily create presentations with convenient audio/video mixers, prebuilt 
templates and touch screen commands. The Rich Media Studio combines both the video and 
VGA/DVI captures into one video stream and delivers it live or on-demand. 

 To deliver a presentation: 

1. Create and deliver a presentation as described in this document. During the presentation 
the Rich Media Studio does a push/pull to a VBrick Reflector or a WM VOD Server.

2. The VBrick Reflector or Windows Media VOD Server streams unicast and/or multicast 
video. It can also push to other reflectors or VOD servers.

3. The live stream is displayed on the Portal Server "Live Broadcasts" page (or on a set top 
box or a Windows Media Player).

4. The video and VGA capture are combined into one stream and displayed in a variety of 
formats, for example side-by-side or "picture-in-picture" as shown in Figure 3.

5. The presentation can be recorded locally on Rich Media Studio's 500 GB hard drive or it 
can be saved with "push button" recording or a scheduled recording (requires the 
Scheduler module) on the VBrick Portal Server.

Audio Input • 1 balanced with Preamplifier 
and Phantom Power for 
Microphone via XLR 
connectors

• 2 Stereo unbalanced via 2 
RCA connectors

• 1 Stereo balanced with 
attenuator via 2 XLR 
connectors

• 1 balanced with Preamplifier and 
Phantom Power for Microphone via XLR 
connectors

• 2 Stereo unbalanced via 2 RCA 
connectors

• 1 Stereo balanced with attenuator via 2 
XLR connectors

Audio 
Output

• 1 Stereo balanced via 2 XLR 
connectors

• 1 Headphone

• 1 Stereo balanced via 2 XLR connectors
• 1 Headphone

Connectivity • 1 eSATA
• 6 USB 2.0 ports
• PS/2 port
• Front:
• 2 USB 2.0

• 1 eSATA
• 4 USB 2.0 ports
• 2 USB 3.0 ports

After 11/2014
• 2 USB 3.0 ports
• 4 USB 3.0 ports

Storage 500 GB 500 GB 

Optical 
Drive

Not available 22X DVD/CD R/RW

Dimensions W x L x H
8.56” x 14.25” x 3.5” 
(217mm x 362mm x 89mm)

W x L x H
5.55 in. x 16.8 in x 12.4 in 
(140mm x 426mm x 315mm)

Weight 11 lbs 15 lbs

Power 500W Input: 100-240V AC Input: 100-240V AC
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Figure 3.  Typical Streaming Presentation

Using the VBrick Template

VBrick provides a fully tested template (with multiple preconfigured outputs) that are ideally 
suited for a variety of presentation and bandwidth scenarios. See Configuring Outputs on 
page 23 for more information.

Playing a Rich Media Stream

Live RMS presentations are typically streamed live and can be viewed on individual desktop 
players. RMS outputs Windows Media streams and H.264 streams. Windows Media streams 
are typically played in a Microsoft Windows Media Player (by pointing to a VBrick Windows 
Media Reflector or to a Windows Media server). H.264 streams are usually played in 
StreamPlayer, Quicktime, or VLC (by pointing to a Darwin server or a VBrick DME).

Stored streams can be archived on the RMS machine but they cannot be played and viewed 
directly from RMS. You can view stored streams from a server or you can view stored 
streams from VEMS. See Viewing Rich Media Streams on page 65 for more information.

Rich Media Studio Versions
As shown in Table 4, Rich Media Studio is available in four versions that run on different hardware 
platforms (the software, except for the templates, is basically the same). Also, as noted in the 
documentation, some features (e.g. Scheduling and Events), are not available in the Standard Edition. 
Each version uses a different template file. RMS Standard and RMS Professional use 
default.session. RMS High Definition and RMS High Definition Portable use defaultHD.session. 

Table 4.  Available RMS Versions

RMS Version Operating System A/V Inputs Outputs Records From

RMS Standard Windows 7 2 video, 2 audio 2 concurrent Touch only
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RMS Professional Windows 7 4 video, 4 audio 4 concurrent Studio and Touch

RMS High Definition Windows 7 4 video, 4 audio 4 concurrent † Studio and Touch

RMS High Definition (
Portable) ††

Windows 7 4 video, 4 audio 4 concurrent † Studio and Touch

† Support for four concurrent HD output streams at 720p using a maximum of four SDI ports.

†† Same as RMS High Definition except the unit is self-contained and includes an integrated display monitor for 
running the management interfaces.

RMS Version Operating System A/V Inputs Outputs Records From



Rich Media Studio Admin Guide 7

Chapter 2

Hardware Installation
Topics in this chapter

What's in the Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
Safety Precautions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
RMS Standard Edition/Professional Edition  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
RMS High Definition . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
RMS High Definition (Portable)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
Defining Audio and Video Inputs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
Starting Rich Media Studio . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19

What's in the Box
The Rich Media Studio appliance is a fully-featured PC that ships with a variety of 
components. Depending on what version of RMS you ordered, your shipment will contain 
some or all of the following components, cables, and connectors. See Figure 4 for a picture 
of each. Use the corresponding installation instructions in this topic to install the RMS 
hardware version you purchased.

Table 5.  RMS Components

RMS Version Component

Standard Edition • RMS unit
• Keyboard and mouse 
• AC power cord
• DVI to VGA adapter

Professional Edition • RMS unit
• RMS Product CD
• Keyboard and mouse 
• A/V adapter cable 
• AC power cord
• DVI to VGA adapter
• DVI Cable (DVI-D)
• Microphone
• XLR cable (male/female)
• Audio adapter cable
• VGA cable (HD15 M/M)
• VGA splitter cable
• USB-to-serial adapter

High Definition Same as Professional Edition not including USB-to-serial adapter. 

High Definition 
(Portable)

Same as Professional Edition with VGA cable (DVI-D) also included.



8 © 2014 VBrick Systems, Inc.

†  The RMS hardware is available in four versions. See Rich Media Studio Versions on page 5 for details. 

Figure 4.  What's in the Box 

Safety Precautions 
There is always a danger present when using electronic equipment. Unexpected high voltages 
can be present at unusual locations in defective equipment and signal distribution systems. 
Become familiar with the equipment that you are working with and observe the following 
safety precautions.

• Every precaution has been taken in the design of your system to ensure that it is as safe 
as possible. However, safe operation depends on you.

• Always be sure your equipment is in good working order. Ensure that all points of 
connection are secure to the chassis and that protective covers are in place.

• Never work alone when working in hazardous conditions. Always have another person 
close by in case of an accident.

• Always refer to the manual for safe operation. If you have a question about the 
application or operation call VBrick for assistance.

• Never allow your equipment to be exposed to water or high moisture environments. If 
exposed to a liquid, remove power safely and send the unit to be serviced by a qualified 
technician. 

     

  Rich Media Studio † USB Keyboard

    

USB Optical Mouse RMS Product CD

  Microphone XLR Cable Male/Female Audio Adapter cable DVI to VGA Adapter

  VGA cable (DVI-D) VGA cable (HD15 M/M) AC Power cord DVI Cable (DVI-D)

  VGA Splitter cable AV Adapter cable USB to Serial Adapter
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Power

When the Rich Media Studio is turned off by using the power switch, power may still be 
supplied to the motherboard. To ensure that the appliance is completely shut down, unplug 
its power cord from its power source. The Rich Media Studio appliance ships with all 
required components installed. There is no need to open the chassis to add or remove 
components. Contact VBrick regarding any malfunction or failure of the Rich Media Studio.

Power Cords 

The plug on the power supply cords are considered to be the equipment disconnect device 
and must be approved for the country where it is used. For USA and Canada, the cord set 
must be UL-approved and CSA-certified. The attachment plug must be an earth-grounding 
type with a NEMA 5-15P (15A 125V) plug and a EN60320/IEC320 receptacle.

Electrostatic Discharge

Static electricity can damage disk drives, circuit boards, and other electronic components. 
Before connecting or disconnecting any device to the Rich Media Studio appliance, we 
recommend you discharge static electricity by first touching an unpainted metal part of a 
grounded PC.

Placement

Use common sense when installing the device. Do not expose the appliance to direct 
sunlight, high humidity or wet conditions. Do not block the air vents or impede the airflow in 
any way. And once installed, do not place anything on top of unit.

Anti-Virus Software

Be aware that the RMS application requires a dedicated platform. Do not install anti-virus or 
other software on the RMS computer. 

RMS Standard Edition/Professional Edition

Overview

The hardware installation instructions for RMS Standard Edition and RMS Professional 
Edition are the same. (To learn more about the differences between these products, see 
Table 2 on page 2.) The Rich Media Studio appliance comes preinstalled with all necessary 
software and does not require additional software installation. The following pages describe 
how to connect your audio, video, and VGA/DVI (RGB) sources. All required cables, 
connectors, and adapters (see Table 2 on page 2) are included with the appliance. 

Note To reduce the risk of electric shock, do not open chassis; do not defeat or remove the 
ground pin of the power cord; and connect only to a properly-grounded AC power 
outlet. No user-serviceable parts are inside, and if you remove the cover, you will void 
the warranty. Contact VBrick for service.

Note The Rich Media Studio contains no user-serviceable parts. If you remove the cover for 
any reason you will also be voiding the warranty.
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Figure 5.  RMS Standard Edition Back Panel (Legacy System)

Figure 6.  RMS High Definition Back Panel (Current System)

A/V Adapter Cable

The A/V adapter cable is used to connect audio and video input sources to the Rich Media 
Studio and audio output from the appliance. Each cable of the A/V adapter is labeled. These 
labels identify the video and audio sources for proper connection of devices to the appliance. 
Connect the A/V adapter ("octopus") cable to the upper slot bracket connector as shown in 
the Figure 7.

Figure 7.  A/V Slot bracket connector with A/V Adapter Cable 
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VGA Input and Output

VGA (RGB) Input 

A splitter cable (Figure 8) is used to connect to the VGA output of an additional computer 
(i.e. presenter's laptop). The splitter cable separates the analog RGB and digital DVI interface 
signals. This separation improves monitor detection and forces the VGA graphics card of the 
computer to enable the digital interface at boot time.

     

Figure 8.  VGA (RGB) Input with Splitter Cable

Dual Head VGA Output

The Dual Head VGA output can be used with either one or two VGA output devices 
(monitors, projectors, etc.). One device is always used to display the Studio console interface. 
If a second device is used, it displays the audience view, which is controlled via the console 
interface. Both outputs support the analog VGA interface and also provide a DVI interface, 
which guarantees a better display quality. Therefore, the DVI interface should be used 
whenever possible. If no monitor or projector with DVI interface is available, a DVI-I to 
HD15 adapter is required for connecting to the DVI-I socket.

Figure 9.  Dual Head VGA Output

The frame rate of the audience view is limited due to the fact that this is the output of the 
RGB source that has been processed. A VGA splitter can be used to connect the VGA source 
to the RGB capture card and to the projector to provide the full frame to the audience view.

Connecting a Video Camera

The Rich Media Studio connects to a variety of video cameras via S-Video or composite 
video outputs on the camera. We recommend using the S-Video output for best video quality. 
When using the S-Video output, connect the camera to the S-Video 1 IN or S-Video 2 IN input. 
When using the composite output, connect the camera to one of the four video inputs Video 
3 IN to Video 6 IN of the A/V adapter cable.
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Power and Network Connections

Use the power connector (Figure 5) on the rear of the unit to connect to an AC power source 
using the provided cable. Connect to your local network using the Ethernet connector. 

Audio Connections

Audio Monitor Output

The Audio monitor output is useful for the operator to preview audio sources or to verify the 
audio quality of the current live stream (recording or broadcasting). Press on the lower-right 
corner of the front panel to access the audio monitor connector. This panel also has additional 
USB and other connectors (see Table 6). 

Figure 10.  Front Panel with Audio Monitor Output

Table 6.  Front Panel Controls and Connectors 

Audio Out for Room Sound System

The Audio output of the Rich Media Studio appliance can be used to connect to the room 
sound system or to a PC speaker set. The A/V adapter cable provides a balanced line-level 
stereo audio out signal (Audio R Out, Audio L Out) via XLR connectors. Standard adapter/

Notes • The Rich Media Studio uses an nVidia graphics card. When two video output 
devices are in use, the nVidia graphics card must be set to DualView in order to 
display the audience view. If it is set to Span, Clone or Single display, the audience 
view will not be displayed in the second VGA output device. The Rich Media 
Studio application also has a mechanism for swapping the assignment of the 
devices. Go to View > Swap Screens to trigger this mechanism. This feature should 
be used when your operator VGA output device is displaying the audience view 
and your audience VGA output device is displaying the console interface. 

• The frame rate of the audience view is limited due to the fact that this is the output 
of the RGB source that has been processed. A VGA splitter can be used to connect 
the VGA source to the RGB capture card and to the projector to provide the full 
frame to the audience view.

DVD-RW Press to eject. Use the DVD drive to update software or burn 
presentations to disk—after they have been recorded. 

Activity LED Yellow LED indicates activity on the hard drive.

XX Power Press XX to power the unit on or off. Blue LED indicates power is on.

Hidden Connector 
Panel

Press on the lower-right corner of the front panel to access additional 
connectors (see Figure 10). These include the audio monitor, an SD/
MMC/MS reader, an eSATA port, and a USB port.
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cables can be used to interface to unbalanced line-level audio input of the room sound system 
or to a PC speaker set.

Figure 11.  Balanced Audio Out XLR (male) connectors 

Phantom Power Microphone

Use a professional balanced audio cable (XLR male and XLR female) to connect the 
microphone to the Audio 1 IN (MIC) input of the A/V adapter cable. It is not necessary to use 
the microphone with a battery; the Rich Media Studio appliance will apply a 48V Phantom 
Power Supply to the microphone by default.

Figure 12.  Balanced Microphone XLR (female) Connector

Mouse and Keyboard 

Connect the mouse and keyboard using any available USB ports on the front or rear of the 
unit. 

RMS High Definition 

Overview

The RMS High Definition system provides high definition output for high definition flat 
panels or similar display devices. It supports up to four 720p high definition streams using 
one or more of the four SDI ports. By default only one SDI port is active; the others are 
available as purchase options. 

Figure 13.  RMS High Definition Back Panel

A/V Adapter Cable

The A/V adapter cable is used to connect audio and video input sources to RMS. It also 
provides audio outputs from the appliance. Each cable of the A/V adapter is labeled. These 
labels identify the video and audio sources for proper connection of devices to the appliance. 
RMS supports connection of multiple S-Video, Composite, and SDI video sources. When 
using the S-Video input, connect the camera to the "S-Video 1 IN" or "S-Video 2 IN" input. 
When using the composite input, connect the camera to one of the four video inputs "Video 
3 IN" to "Video 6 IN" of the A/V adapter cable.
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Figure 14.  Back Panel with A/V Adapter Cable

VGA/DVI (RGB) Input

A splitter cable is used to connect the VGA/DVI output of a computer (presenter’s laptop 
for example). The splitter cable separates the digital DVI and the analog VGA interface 
signals. This separation improves monitor detection.

Figure 15.  VGA/DVI Inputs with Splitter Cable

HD SDI Input

The HD SDI input must be connected to the correct BNC port on the left panel. Caps 
should already be in place to cover the other BNC ports. Beginning with RMS 1.7, audio has 
been enabled over HD SDI inputs.

Figure 16.  HD SDI Input
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DVI/HDMI Display Output

The DVI/HDMI display outputs can be used to connect either one or two output devices 
(monitors, projectors, etc.). The secondary display can be used to show a video mix 
controlled via the RMS software.

Figure 17.  DVI/HDMI Display Outputs

Audio Connections

Audio Monitor Output

If you want to use headphones, connect them on the left panel. 

Audio Out for Room Sound System

The Audio output of the Rich Media Studio appliance can be used to connect to the room 
sound system or to a PC speaker set. The A/V adapter cable provides a balanced line-level 
stereo audio out signal (Audio R Out, Audio L Out) via XLR connectors. Standard adapter/
cables can be used to interface to unbalanced line-level audio input of the room sound system 
or to a PC speaker set.

Figure 18.  Balanced Audio Out XLR (male) connectors 

Phantom Power Microphone

Use a professional balanced audio cable (XLR male and XLR female) to connect the 
microphone to the Audio 1 IN (MIC) input of the A/V adapter cable. It is not necessary to use 
the microphone with a battery; the Rich Media Studio appliance will apply a 48V Phantom 
Power Supply to the microphone by default.

Figure 19.  Balanced Microphone XLR (female) Connector

Mouse and Keyboard

Use the USB ports when connecting the mouse and the keyboard to the RMS appliance. 
These devices are shipped in their original packaging, manual and installation instructions. 
For more information and installation instructions, please follow the original manufacturer 
documentation.
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RMS High Definition (Portable)

Overview

The RMS High Definition (Portable) unit is a self-contained device with an integrated 
monitor. This portable unit supports 3M MicroTouch Software for touch screen operation. 
See Using 3M MicroTouch on page 71 for more about this. The left and right panels are 
shown in Figure 20. The figure contains all of the input interfaces available but may not 
reflect actual positioning on the hardware device.

Figure 20.  RMS High Definition (Portable) Left and Right Panels

A/V Adapter Cable

The A/V adapter cable is used to connect audio and video input sources to RMS. It also 
provides audio outputs from the appliance. Each cable of the A/V adapter is labeled. These 
labels identify the video and audio sources for proper connection of devices to the appliance. 
RMS supports connection of multiple S-Video, Composite, and SDI video sources. When 
using the S-Video input, connect the camera to the “S-Video 1 IN” or “S-Video 2 IN” input. 
When using the composite input, connect the camera to one of the four video inputs “Video 
3 IN” to “Video 6 IN” of the A/V adapter cable.

       

Figure 21.  Back Panel with A/V Cable
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VGA/DVI (RGB) Inputs 

A splitter cable is used to connect the VGA/DVI output of a computer (presenter’s laptop 
for example). The splitter cable separates the analog VGA and digital DVI interface signals. 
This separation improves monitor detection.

    

Figure 22.  VGA/DVI Input with Splitter Cable

HD SDI Input

The HD SDI input must be connected to the correct BNC port on the left panel. Caps 
should already be in place to cover the other BNC ports. Be aware that when using SDI input 
on High Definition systems, the audio signal is not included with the SDI input. This means 
you will need to connect the source audio input to the audio input connector on the A/V 
adapter cable. 

Figure 23.  BNC Connector for SDI Input

VGA/DVI Display Outputs

The VGA/DVI display outputs can be used to connect either one or two output devices 
(monitors, projectors, etc.). The secondary display can be used to show a video mix 
controlled via the RMS software.
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Figure 24.  VGA/DVI Display Outputs

Audio Connections

Audio Monitor Output

If you want to use headphones, connect them on the left panel. 

Audio Out for Room Sound System

The Audio output of the Rich Media Studio appliance can be used to connect to the room 
sound system or to a PC speaker set. The A/V adapter cable provides a balanced line-level 
stereo audio out signal (Audio R Out, Audio L Out) via XLR connectors. Standard adapter/
cables can be used to interface to unbalanced line-level audio input of the room sound system 
or to a PC speaker set.

Figure 25.  Balanced Audio Out XLR (male) connectors 

Phantom Power Microphone

Use a professional balanced audio cable (XLR male and XLR female) to connect the 
microphone to the Audio 1 IN (MIC) input of the A/V adapter cable. It is not necessary to use 
the microphone with a battery; the Rich Media Studio appliance will apply a 48V Phantom 
Power Supply to the microphone by default.

Figure 26.  Balanced Microphone XLR (female) Connector

Mouse and Keyboard

Use the USB ports when connecting the mouse and the keyboard to the RMS appliance. 
These devices are shipped in their original packaging, manual and installation instructions. 
For more information and installation instructions, please follow the original manufacturer 
documentation.
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Starting Rich Media Studio 
Before you can deliver a presentation you will need to configure both the application and the 
templates as explained below. In the Rich Media Studio application, you will need to rename 
the audio and video sources and define a camera input source using the Hardware 
Configuration Console. Then you will need to configure the template(s) with relevant 
parameters depending on how you will be delivering your presentations. After you have 
connected all cables and adapters, power-on the appliance.

 To start Rich Media Studio: 

1. Attach AC power cord to power receptacle on rear of unit. 
2. Power-on by pressing the power switch. On some models a blue light will illuminate 

when power is applied.
3. Click on Work when prompted to Select a location for the "vbloc" network 
4. Click on Close when The network location is now Work message is displayed. 
5. Click on the VBrick Rich Media Studio icon on the desktop to launch Rich Media Studio. 

The RMS Splash page shown in either Figure 27 or Figure 28 will be displayed.

At this point you are ready to begin. The next step is to define your audio and video inputs. 
See Defining Audio and Video Inputs on page 21. After getting started we highly recommend 
that you install all critical Microsoft updates; see Installing Windows Updates on page 67 for 
more information. 

Figure 27.  Splash Page – RMS Standard Edition

Note If you have logged off from the Start menu, or you need to login using Remote 
Desktop Connection (RMS High Definition only), the login credentials are 
administrator and VBrick1234

Launch Session Builder to select inputs and define outputs for your audio/video 
mixes. Session Builder is a subset of Session Studio and has reduced functionality.
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Figure 28.  Splash Page – RMS Professional Edition/RMS High Definition

Checking the Version Number

When requesting support or checking for upgrades, the current version number of the 
application is shown on the Help > About page. Go to http://www.vbrick.com/support to 
inquire about an upgrade. 

Launch a Touch Session to select a "touch" presentation.

Go to the Archives folder where recorded presentations are saved.

Launch Studio Session to select inputs and define outputs for your audio/video 
mixes. Studio Session is a superset of Session Builder and has additional 
functionality.

Launch a Touch Session to select a "touch" presentation.

Go to the Archives folder where recorded presentations are saved.

http://www.vbrick.com/support/
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Defining Audio and Video Inputs
Before you can configure and use the outputs you will need to define the video input sources 
as explained below. The Standard Edition has 2 audio inputs and 2 video inputs. The 
Professional Edition has 4 audio inputs and 4 video inputs. The inputs for the High 
Definition versions are shown in Table 3 on page 3. To get started, click on the Session 
Builder/Studio icon and then go to Tools > Hardware Configuration. 

Defining the Camera Input Sources

After you rename the Audio and Video Source as explained below you will need to associate 
the possible Video Sources in the tree menu on the left with the physical cable to which the 
cameras are actually connected (or may be connected). The A/V adapter cable has six video 
inputs and the Source dropdown in the Hardware Configuration Console has six 
corresponding choices. You must select a Source from the dropdown list (Figure 29) that 
matches the input cable you are actually using for the camera. Note that the first two sources 
(Vin-1-Y/C and Vin-2-Y/C) are for cameras with S-Video connectors. The remaining sources 
(Vin-3 thru Vin-6) are for cameras with RCA connectors. 

 To define an input source for your camera 

1. Highlight the Presenter video source in the tree control. 
2. From the Source dropdown, select the actual input cable to which your camera is 

connected.
3. Exit the Hardware Console and you are done. Your changes will be automatically saved.
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Figure 29.  Hardware Configuration Console – Standard Edition

Figure 30.  Hardware Configuration Console – Professional Edition
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Chapter 3

Configuring Outputs
Topics in this chapter
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Overview
VBrick provides preconfigured templates that, depending on your bandwidth and network 
environment, will provide the best viewing experience for your viewers. RMS Standard and 
RMS Professional use the default.session template. RMS High Definition and RMS High 
Definition Portable use the defaultHD.session template. The outputs for these templates are 
shown in Figure 32 and Figure 32. The template is stored locally in the following folder. It is 
strongly recommended that you backup the template and save it in a convenient location.

C:\Users\RMS\Documents\VBrick\Rich Media Studio\Sessions\

These templates have been tested and are fully supported by VBrick. They each have multiple 
outputs defined. The outputs include configurations for Windows Media, Silverlight, and 
H.264. All have one output that streams VGA output from a desktop to an overhead 
projector. Each output is configured with standard "presets." 

Figure 31.  Outputs (RMS Standard/RMS Professional) 



24 © 2014 VBrick Systems, Inc.

Figure 32.  Outputs (RMS High Definition/RMS High Definition Portable)

Best Practices

When using the preconfigured outputs in default.session or in defaultHD.session, it is 
important to remember that these outputs are designed for streaming relatively stable, low-
motion content such as that delivered from a classroom or lecture hall. In this environment 
the template will provide a high-quality viewing experience using a minimal network 
bandwidth. However, if you will be streaming high motion content and/or flipping slides 
quickly, you may need to either increase the video bitrate or lower the video resolution. For 
the best streaming results with your content and in your environment, experiment with 
different combinations of resolution and bit rate until you get the best possible stream quality 
given the network and bandwidth constraints at your site. If frames are being dropped in 
high-motion H.264 streams for example, the most relevant encoding options to modify are 
Target Bit Rate or Performance (the options vary depending on the template) (Note: click on 
the arrow below each section to expand or contract the options; mouseover each option to 
see a description.)

Note After closing the Rich Media Studio, you must wait approx. 15 seconds before opening 
the Studio Touch console, and vice versa. Otherwise you will receive a message stating 
that an instance of the application is already running.
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Using the Template
RMS provides preconfigured templates that make it easy to get up and running. Table 7 and 
Table 8 show the configuration values for all template outputs. Some templates are designed 
for use over the Internet and have lower Video Bit Rates. Others are designed for a High 
Definition or LAN environment and have higher Bit Rates. Select the template that provides 
the best viewing experience for your end users. You may have to experiment with different 
templates but the object is to select the best possible size and frame rate given the bandwidth 
available at your site. In general, the Low and Medium templates use less bandwidth for (1) 
uploading the stream to a reflecting service and for (2) downloading the stream to the clients 
viewing the presentation. 

The font sizes used in the presentation, and the rate at which the slides or desktop view 
changes, combine to determine the viewing experience. For example, if you are streaming an 
Excel spreadsheet with small fonts, you will need a template that has higher bandwidth and 
larger frame size. Use the "high" version of the template if you will be flipping slides or 
presets frequently.

Note Be aware that default.session and defaultHD.session are read-only and cannot be 
changed. When changing the outputs associated with the template, go to File > Save 
Session As and save the file with a new name, for example my_session.session. 

Note If your presentation uses small fonts, for example 10 pts. or less, you will want to use a 
higher-bandwidth template with a larger frame size. If your presentation uses larger 
fonts, you can use a template with less bandwidth and a smaller frame size. VBrick 
recommends using fonts of 14 pt. or higher.
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Table 7.  Template Output Values (RMS Standard, RMS Professional)

Table 8.  Template Output Values (RMS High Definition, RMS High Definition Portable)

†  This is a high definition "archive" stream. It does not broadcast from the RMS.

In all cases you should select a template that maximizes the viewing experience for end users. 
As shown above, the templates are designed for output to specific screen sizes. Each of the 
templates has frame size (width and height) dimensions that determine the size of the 
encoded window. This encoded window will be played at 100% on the end user player (in a 
Windows Media Player for example). 

Be aware that there is always a finite amount of streaming bandwidth available. If the data in 
the encoded stream exceeds the available bandwidth, end users may experience freeze frames or rough 
transitions between frames. Larger frame sizes with more detail (for example Excel spreadsheets 
with tiny fonts) will encode more data and consequently require more bandwidth for smooth 
transitions. Smaller frame sizes and less detail are ideal for Internet streaming.

Template Width Height Frame Rate Video Bit Rate Audio Bit Rate

H.264 - High 1280 (px) 720 (px) 29.97 (fps) 1300 (kbps) 128 (kbps)

H.264 - Medium 1024 576 29.97 1000 64

H.264 - Low 800 450 29.97 500 32

Windows Media - High 1280 720 29.97 1300 128 Low Delay

Windows Media - Medium 1024 576 29.97 1000 64 Low Delay

Windows Media - Low 800 450 29.97 500 64 Low Delay

Silverlight - High 1280 720 29.97 1300 128 Low Delay

Silverlight - Medium 1024 576 29.97 1000 64 Low Delay

Silverlight - Low 800 450 29.97 500 64 Low Delay

Template Width Height Frame Rate Video Bit Rate Audio Bit Rate

Windows Media - HD 1280 (px) 720 (px) 29.97 (fps) 1300 (kbps) 128 Low Delay (kbps)

Windows Media - Medium 1024 576 29.97 1000 64 Low Delay

Windows Media - Low 800 450 29.97 500 64 Low Delay

Silverlight - HD 1280 720 29.97 1300 128 Low Delay

Silverlight - Medium 1024 576 29.97 1000 64 Low Delay

Silverlight - Low 800 450 29.97 500 64 Low Delay

H.264 - MPEG2TS Broadcast 1280 720 29.97 1300 128

H.264 - HD Broadcast 1280 720 29.97 1300 128 

H.264 - Medium Broadcast 1024 576 29.97 1000 64

H.264 - Low Broadcast 800 450 29.97 500 32

H.264 - HD Archive † 1440 1080 29.97 3000 128

Note Keep in mind that with smaller frame sizes you will need larger fonts to make your 
presentation viewable. Smaller fonts will be viewable with larger frame sizes but you 
will need more bandwidth for smooth transitions. 
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Modifying the Template 

VBrick encourages you to use the predefined templates but recognizes that in some cases you 
may want to modify these templates or create your own. While the steps outlined below are 
relatively easy, it is important to remember that a successful presentation depends on many 
factors. Chief among them are bandwidth, resolution, and frame rate. If there is an issue with 
any of these critical factors, the quality of the presentation may be affected and your viewers 
may experience freeze frames, buffering, or other unexpected results. For this reason, VBrick 
recommends that you start with a predefined VBrick template and avoid changing the 
resolution or frame rate. For best results create and save a template in advance (with presets). 
Then use Studio Touch to deliver the presentation. Do not try to run a live presentation 
directly from Rich Media Studio unless you are thoroughly familiar with the application.

Also be aware that the video and slides you see in the Rich Media Studio application are not 
what your end users will see. Remote viewers may be affected by bandwidth issues, desktop 
limitations, and other factors. It's always a good idea to test your audio, video, and slides locally and 
remotely before presenting to a live audience. This can help identify problems in advance and 
provide your viewers with an optimal viewing experience. There is no substitute for a 
thorough walk-through that can anticipate and address potential issues—particularly with 
your network. This will test the presentation on your local network and/or over the public 
Internet and will provide a real-world test in a simulated production environment.

 To create your own template:

1. Begin by selecting the predefined VBrick template. Choose a low bandwidth output if 
most of your end users will be viewing the presentation over the public Internet. Choose 
a higher bandwidth output if most of your viewers are on a local network. See Using the 
Template on page 25 for recommendations and guidelines.

2. If necessary, define your camera input source(s) using the Hardware Configuration 
Console. See Defining Audio and Video Inputs on page 21.

3. Using Rich Media Studio, create a template and define the presets using your available 
audio and video inputs. See Using Session Studio/Builder on page 43.

4. Save the template with a new name to a known folder. For best results create a subfolder 
in the Sessions directory and use care not to overwrite the original template. 

Configuring Windows Media Outputs 
Rich Media Studio has different templates for RMS Standard or Professional and for RMS 
High Definition. The appropriate template (default.session or defaultHD.session) can be 
used to configure multiple WM output streams. Before you can use the preconfigured 
Windows Media outputs, each one must be configured and saved with "push" and/or "pull" 
parameters as explained below. In the Distribution pane of the Output Editor (see below) one 
or more of the options must be enabled. Whenever possible, VBrick recommends configuring the 
appliance to enable a "pull" from a VBrick Reflector or a Windows Media Server. When using a 
pull, the connection will be automatically restored if there is a network disruption.
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Figure 33.  Windows Media Template 

Configuring for Pull

Configuring a VBrick Reflector for Pull

If the appliance is configured to enable a pull from a reflector, open the Reflector 
configuration page and set the Reflector Source to Pull Receiver (Figure 34) and the Source 
URL to http://<Rich_Media_Studio_IP_Address>:8881 See the "Configuration: Reflector" 
topic in the WM Appliance Admin Guide for details. 

Broadcast (Pull) Pull is recommended whenever possible. Pull enables a reflector or 
server to "pull" the stream from the specified port (8881 for example) 
on the appliance. To do this you will need to create a "Pull Receiver" on 
the reflector and/or a "Pull Publishing Point" on the server (see below).

Broadcast (Push) Push enables the appliance to "push" the stream to a reflector or server. 
To do this you will need to create a "Push Receiver" on the VBrick 
Reflector and/or a "Push Publishing Point" on the server (see below). 

../PDF_Files/WM_AdminGuide.pdf
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Figure 34.  Pull Receiver Configuration

Configuring a Windows Media Server for Pull 

If the Rich Media Studio is configured to enable a pull from a Windows Media Server, create 
a broadcast publishing point on the server and point the publishing point to the URL of the 
Rich Media Studio, for example: http://<Rich_Media_Studio_IP_Address>:8881. When you 
start the publishing point it pulls the stream from the Rich Media Studio. You can optionally 
enable the "Start publishing point when first client connects" feature in the publishing point's 
general properties to have the server wait for a client to connect before it starts the pull from 
the appliance. 

Configuring for Push

After starting a presentation that "pushes" the stream to VBrick Reflector or a Windows 
Media (VOD-WM) Server, it takes 10–15 sec. for the push to actually start on the reflector or 
server.

Configuring a VBrick Reflector for Push

Conversely, if you will be "pushing" to a VBrick Reflector, you will need to set the Reflector 
Source to Push Receiver (Figure 35) and name a Publishing Point. You will also need to enter 
the push destination URL in the URL field in the Rich Media Broadcast (Push) pane (see 
Figure 33) in this format: http://<VBrick_Reflector_ip_address>:port/
<publishing_point>. (Do not use the Template URL field.) 
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Figure 35.  Push Receiver Configuration

Configuring a Windows Media Server for Push

If the appliance is configured to enable a push to a server, you will need to create a "Push 
Publishing Point" (authenticated or non-authenticated) on the server. See the "Creating 
Publishing Points" topic in the VOD-WM Server Admin Guide for more information. Refer 
to the Microsoft Windows Media Services documentation for complete details.

Configuring for Silverlight 

Silverlight configuration is basically the same as Windows Media with some exceptions. For 
example you must enable Script Stream on Silverlight outputs in order for Silverlight to work 
with VEMS. You will also need to set the Complexity Level to Lowest for the 
Silverlight - High (and Windows Media - High) templates. 

http://www.microsoft.com/windows/windowsmedia/forpros/server/server.aspx
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Configuring for Multicast 

The Rich Media appliance uses unicast to send the stream to a reflector or server from where 
it can be transmitted via multicast to multiple end users. Multicast is automatically enabled on 
the VBrick WM Reflector (if Transmit is enabled on the Configuration: Encoder > Multicast 
page). Multicast is not automatically enabled on a Windows Media Server. To enable multicast 
on a Windows Media Server you must run the Multicast Announcement Wizard when creating 
Publishing Points. This will allow you to create and generate .nsc files which point the end user 
to the multicast stream. 

Configuring for VEMS

To have the reflected stream automatically appear on the Live Broadcasts page of the VEMS 
Portal Server, configure the IWS configuration page for a WM appliance as follows. For more 
about delivering an RMS presentation, see Using RMS with VEMS on page 42.

Configuring for VBOSS

Use the following steps to send a Windows Media stream to VBOSS (VBrick's Online 
Streaming Service).

 To configure for VBOSS: 

1. Open VBOSS (v2.2 or higher) and go to the Windows Media Settings page.
2. In the Live Webcast Publishing Info section (see below), note the configured Server Name 

and Publishing Point. 

Note The only way to make stored Silverlight presentations available in VEMS is via FTP. 
See the "Authoring RMS Presentations" topic in the Portal Server User Guide for 
more information. 

Unicast Go to the Configuration: Reflector > Server page complete the Announce 
HTTP and RTSPU Server section

Multicast      Go to the Configuration: Reflector > Multicast page and enter a valid 
Multicast Destination IP Address.

http://technet.microsoft.com/en-us/library/cc753602.aspx
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3. Open RMS, go to the Session Properties page, and click on the Outputs tab. 
4. Open any Windows Media output and click on the Options tab. 
5. Scroll down to the Broadcast Push section and open the dropdown menu.
6. In the URL field, enter the Server Name and Publishing Point from the VBOSS (Live 

Webcast Publishing) page in the format: http://<server_name>/<publishing_point> 
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7. Make sure the Broadcast (Push) is Enabled and that Auto Destroy in unchecked. 
8. Click the Test button to verify the connection. 
9. If successful click OK and OK to save and exit. This will make the stream available in 

VBOSS user interface.

Configuring H.264 Outputs
Rich Media Studio has different templates for RMS Standard or Professional and for RMS 
High Definition. The appropriate template (default.session or defaultHD.session) can be 
used to configure multiple H.264 output streams. See Table 4 on page 5 for more about RMS 
models. See the H.264 Encoder Admin Guide for more about H.264 encoder configuration. 

Configuring for VEMS 

If you will be configuring VEMS to play a live stream from RMS you will need to configure 
an .sdp (session description) file as explained here. The .sdp filename identifies the RMS 
stream that will be displayed on the Live Media page in VEMS. The .sdp file is dynamically 
created when you press the "Record" button.

 To configure an .sdp file: 

1. Go to the Start page and click on the Session Builder. 
2. Go to the Session Properties page and click on the Outputs tab. 
3. Then click Options, scroll down to the Broadcast section, and open the dropdown menu.

Figure 36.  Broadcast Options (Part 1)

4. Enter a Session Name. This name (no special characters or spaces) must match the name 
of the .sdp file (see below) and is the "program name" that will be displayed on the Live 
Media page in VEMS.

5. Verify that the Origin Creator Name is RMS: 
6. The Outgoing Network Interface is auto-populated with the IP address of the RMS unit 

but you can override as necessary. 

../PDF_Files/H264_AdminGuide.pdf
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7. Scroll to SDP File Name and give the .sdp file a unique name that matches the Session 
Name specified in Step 4 above, for example: C:\inetpub\wwwroot\RMS_Session.sdp Do 
not change anything else in the path.

Figure 37.  Broadcast Options (Part 2) 

8. When done, save your changes and click the "record" button. This will dynamically create 
the .sdp file. 

9. Go to VEMS and the stored stream will be available on the Live Media page. 

Configuring for DME

You can use a unicast push or a multicast to send the H.264 output stream from RMS to 
VBrick's Distributed Media Engine (DME). With both methods you will also need to publish 
the .sdp file to the DME. You can use any of the H.264 templates shown in Table 8 on 
page 26 to stream to the DME. As explained below, you will need to perform the following 
steps to configure a RMS stream for the DME:

 To configure a stream for a DME:

1. Enter a destination address on the Broadcast page. In the Destination Address field 
(Figure 36) enter a multicast IP address (for example 239.2.127.254) or the unicast IP 
address of the DME.

2. Extract the .sdp file. Once the session is active, the .sdp file is automatically created (in 
the specified folder) when you "enable" the broadcast and name the file using the SDP 
File Name field (Figure 37). 

3. Verify the .sdp file. When creating an .sdp file, the information in the file is sourced from 
the Broadcast page in RMS. Be aware that any leading spaces (see line 3 below), will 
cause the .sdp file to fail when published to the DME. For this reason, be sure to delete 
leading spaces before publishing the .sdp file to the DME. 
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4. Publish the .sdp file (via FTP) to the root folder on the DME. After you FTP the file, a 
live RTP stream will be available in the DME that can be served in a variety of ways (see 
Figure 38). For example you can reflect the stream as a multicast relay or auto-unicast it 
to another DME. See the DME Admin Guide for more information.

Figure 38.  RMS/DME Integration 
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Chapter 4

Delivering a Presentation
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Touch Session Basics
Studio Touch is a simplified interface which includes only the functionality a presenter 
requires to start a recording and switch among defined presets created in Rich Media Studio's 
Session Studio/Builder interface. RMS Touch was designed for the presenter and enables the 
presenter to easily create a recording without having to configure and manage audio and 
video presets. To use Studio Touch, the latest templates must be present in the Sessions 

folder. See Configuring Outputs on page 23 for more information.

In many cases, and depending on your familiarity with the application, you may wish to have 
a second person help with the presentation. For example, if you will be switching presets 
and/or changing PowerPoint slides frequently, it helps to have a second person flip the slides 
so you can focus on the presentation. It also helps to keep in mind the simple things that help 
make an effective and persuasive presentation. For example, use as much light as possible. All 
video looks better and more professional when it is well lit and you use a good quality 
camera. And most importantly, look at the camera as much as possible. Unless you have a 
local audience, always speak directly to the camera.

Notes • You cannot run two instances of Rich Media Studio at the same time. An error 
message will indicate that one of these applications is already running.

• PowerPoint is not installed on the Rich Media platform. If you will be delivering 
PowerPoint presentations, PowerPoint must be installed on your laptop. 

• The RMS High Definition (Portable) unit supports 3M MicroTouch Software for 
touch screen operation. See Using 3M MicroTouch on page 71 for more about this. 
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Figure 39.  Recording in Progress 

When the red button begins to flash your presentation is live. You can start talking and using 
the presets to switch between audio and video outputs and change the camera position. To 
stop a recording, simply click the Record button again. (The Rich Media Studio has a 500 GB 
hard drive and at some point you may need to create disk space for new recordings. See 
Managing Disk Space on page 67 for more about this.) As noted, you use the presets to 
switch between available outputs views. There are different presets associated with each 
template. When you click a preset, the preset "view" is encoded and streamed to viewers. For 
example, during a presentation you can switch back and forth between the views as 
necessary—or this can be done by an assistant. 

Using the Presets

Each template is associated with fixed "preset" outputs. During a presentation you simply 
click on the preset to change the "view" that is streamed to viewers. For example when 
speaking directly to the audience you might want to stream a Camera Only view; when 
discussing a PowerPoint slide, you might want to go to PC Only. If you have two output 
streams, as shown in Figure 42, the presets will change the output for both streams. 
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Delivering a Touch Presentation 
The Session Builder is the Standard Edition interface is where you select inputs and define 
outputs for your audio-video mixes (Studio Session is the Professional Edition interface). 
Session configurations are saved in the Session Builder so they can be launched in the Studio 
Touch interface. The following steps show the typical steps you will follow to deliver a 
presentation. The steps are basically the same for Standard Edition and Professional Edition. 
The workflow assumes that the session has been configured (i.e. that all inputs and outputs 
have been defined) and the presenter is ready to deliver a presentation. 

 To deliver an RMS presentation:

1. Click on the desktop icon to launch Rich Media Studio. 

Camera Only PC Only 

Camera and PC PC and Camera 

Side-by-Side 
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Figure 40.  Start Page

2. When the Start page (Figure 40) is displayed, click on the Touch icon. This will display 
the Session page with the Touch menu. 

Figure 41.  Touch Menu

3. Click on a predefined template to open the Session Builder. Click on Current to launch 
the last configuration that was used for a presentation.
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Figure 42.  Session Builder 

4. When you are ready to deliver the presentation, click on the Record button to start 
streaming audio and video. The Record button blinks in red to indicate that the 
presentation is live and a recording is in process. If the template is not enabled for 
recording, the button will still flash but the presentation will not be recorded. See 
Archives on page 46 for more about archiving. 

5. Use the presets on the right to change the way your output is displayed. If you have two 
output streams, as shown in Figure 42, the presets will change the output for both 
streams.

6. When you are finished delivering the presentation, click on the Record button again.
7. After a few moments (depending on the length of the recording) a Windows Explorer 

window (Figure 43) will open showing where the recorded files(s) are archived. In this 
example there are archives for two streams. Drill down into the folder to see the actual 
H.264 (.mp4) and Windows Media (.wmv) files. 
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Figure 43.  Archive Folder Window

Using RMS with VEMS 
RMS presentations are authored and delivered in two places: on the VEMS server and on the 
RMS platform. When the live RMS presentation is complete, it can be saved (i.e. FTPed) to a 
virtual directory on the VEMS server from where it can be published to the Media Library. 
For details, see "Configuring for Presentations" in the Portal Server Admin Guide. See also 
"Authoring RMS Presentations" in the Portal Server User Guide. 

../PDF_Files/PortalServer_AdminGuide.pdf
../PDF_Files/PortalServer_UserGuide.pdf
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Chapter 5

Using Session Studio/Builder
VBrick strongly recommends using the preconfigured templates provided with the RMS 
application. These templates are designed to provide an optimal viewing experience for your 
users and have carefully selected values (see Table 8 on page 26) for bandwidth, frame rate, 
and resolution. The Rich Media Studio functionality described in this chapter is designed 
for advanced users who wish to build additional, customized templates. Use this 
functionality with care. This added flexibility means you can also create templates that will 
produce poor or unacceptable results given the bandwidth available to your viewers. See 
Touch Session Basics on page 37 for recommendations and guidelines.
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Overview
Rich Media Studio consists of two interfaces: the Session Studio/Builder interface and the 
Touch Session interface. The Session Studio interface, described in this chapter, is used to 
create mixes of different input and output deliverables and to define presets that will be used 
for delivering a presentation. Different configurations can be saved for each individual 
presenter or situation. The Touch interface (see Touch Session Basics on page 37) is a 
simplified interface with specific presets for each template. It provides all the functionality 
needed to deliver a presentation and switch between presets. The selections on the menu bar 
are explained below: 

Note Session Builder for RMS Standard (and Session Studio for RMS Professional) denote 
the interfaces used to create mixes of different input and output deliverables and to 
define presets. Session Builder cannot record a presentation. 

File • Load Session – load a previously saved session (i.e. a template). 
• Save Session As – saves the current session. Modified session properties 

are not saved until you save the session.
• Archives – go to the folder where archived (i.e. saved) recordings are 

stored.

View Go to fullscreen or cancel fullscreen.
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Figure 44.  Studio Session Interface

Tools
The following options are available from the Tools menu.

Session        • Properties – launches the Session Properties page from which you can 
choose Metadata, Inputs, or Outputs for the current session. 

• Record – start or stop a recording. 

Tools • Hardware Configuration – launches the Hardware Configuration 
Console which is used to define audio and video inputs.

• Scheduler – launches the Scheduler.

Help • Product Website – opens the VBrick website. 
• Online Help – displays the online help system. 
• Check for Updates – opens a VBrick Support Services page. 
• About – shows the version number of the current build. 

Exit to Start menu.

Open the Properties page for this session.

Record | Stop Record. Turns red and blinks when a recording is in progress 
(not available in Session Builder for Standard Edition). 

Hardware Configuration This option is used to configure the audio and video inputs. See 
Defining Audio and Video Inputs on page 21 for details.

http://www.vbrick.com/support/index.asp
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Hardware Configuration 

Before you can configure and use the templates you will need to rename the audio and video 
sources and define the camera input sources. Defining Audio and Video Inputs on page 21 
explains how to use this page.

Options

Use this page to set various configuration options such as the default path for archived 
recordings. 

Sessions 

Use this page to configure Pre-Record and Post-Record Actions as desired. For example you 
can use the Path field to point to a script or an application that will FTP the recorded file to a 
Video on Demand server using the specified Arguments. 

Scheduler Launches the Scheduler (not available in Session Builder for 
Standard Edition). 

Options Use this page to set various configuration options such as the 
default path for archived recordings.



46 © 2014 VBrick Systems, Inc.

Figure 45.  Sessions

Archives

This page sets the path to the folder where presentation recordings (i.e. archives) will be 
saved. 

C:\Users\RMS\Documents|VBrick\Rich Media Studio\Archives 

Pre-Record Action Pre-Record Actions are actions initiated when a recording begins 
such as running an executable to perform a task when a recording 
begins. 
• None – performs no action when stopping a recording.
• Run – performs the task specified in the Path field when stopping 

a recording.
• Arguments – passes optional parameters to the executed task 

when stopping a recording.
• Wait for Completion – stops the recording after completion of the 

task specified in Run. Leaving this unchecked will immediately 
stop the recording, even if the specified Run task is still running.

Post-Record Action Post-Record Actions are actions initiated when a recording is 
stopped. 
• None – performs no action when a recording is started. This is 

the default option.
• Run – performs the task specified in the Path field when starting a 

recording.
• Arguments – passes optional parameters to the executed task 

when starting a recording.
• Wait for Completion – begins recording after completion of the 

task specified in Run. Leaving this unchecked will immediately 
start the recording, even if the specified Run task is still running.

• Show Folder View – opens the directory in which the recordings 
are archived in an Explorer window. This is the default option.
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All templates are configured by default to enable recording. Click the Record button once to 
start a recording and once again to end a recording. After a few moments the output folder 
will open showing the recording you just made. The recording is saved with the template 
name you used when making the recording. To change the default recording path, go to Tools 
> Options > Archive. You may wish to disable recording entirely if, for example, you will be 
recording a presentation on the VBrick Portal Server.

 To enable/disable recording. 

1. Launch the Rich Media Studio.
1. Go to Session > Properties > Outputs. 
2. Select an output and click Edit and Options. 
3. Check to enable/disable archiving as appropriate. 
4. Scroll down tho the Archive section and enable or disable as appropriate.
5. Click OK when done. 
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Remote Control

If enabled, the Remote Control option lets you control the RMS remotely via API. 

Port Specifies the port through which the remote API will communicate.

Object Name Specifies the name of the object that will be used to communicate with 
the API.
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General 

This option determines whether the Session Properties page will display when the application 
starts. 

Launching a Session
After the Rich Media Studio hardware is configured, you can begin creating mixes for your 
presentations. Launch the Rich Media Studio console interface by double-clicking the Rich 
Media Studio shortcut on your Windows desktop.

Session Properties

By default, the Rich Media Studio console interface will launch and the Session Properties 
window will appear which includes tabs for Metadata, Inputs, and Outputs. The default 
display of the Properties page is enabled or disabled on the General tab of the Options page.

Figure 46.  Session Properties Window
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Metadata

Metadata is the information about a Rich Media Studio configuration. It contains 
information describing a session's Title, Author, Copyright, Rating, Credits, Description and 
Keywords and is used to facilitate the understanding, characteristics, and management usage 
of data. The Title field is populated with the template name if you opened a template. 

Inputs

Audio and video input devices connected to the Rich Media Studio are displayed under the 
Inputs tab. Some typical inputs include: By checking the devices under the Use column, 
selected devices will appear in the Rich Media Studio console interface as available inputs that 
can be captured in a presentation.

Figure 47.  Session Inputs
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Figure 48.  Available Input Devices

Advanced Input Editor

Advanced editing options allow you to crop and scale RMS device inputs. The parameters in 
the Target panel in the Advanced Input Editor allow you to scale video to account for 
anamorphic video inputs (i.e. images with unequal magnifications). 

In the example on the right, there are five 
inputs: three video sources (including a 
laptop), and two audio sources. The Rich 
Media Studio console interface (right) displays 
the three video inputs and both audio inputs.

In the example on the right, one of the video 
sources and one of the audio sources have 
been removed. The Rich Media Studio console 
interface (right) no longer displays the 
unchecked video and audio sources as available 
inputs.
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 To edit an input:

1. Select a Video Input on the Session Properties page and click the Edit button.
2. Click on the Advanced button to display the Advanced Input Editor window with two 

video preview panes (Source and Target). 
3. Adjust the parameters as necessary and click Apply to save your changes.

Outputs

Under the Outputs tab are the possible output Types. The selected outputs will determine 
what deliverables (for example streams for the web, Windows Mobile, or iPhone) will be 
created for the end user when a recording is completed. With Rich Media Studio, all output 
types are created simultaneously and are available immediately after completing a recording. 

Deinterlace Check this box to get optimum quality when displaying TV-like material 
(for example DVDs) on a computer. 

Auto Format Check this box to let RMS auto format the output stream.

Source     Indicates the width, height and frame rate of the video source.

Target Lets you modify the width, height and frame rate of the output and lets you 
define a cropping rectangle to crop your video outputs.
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Figure 49.  Session Outputs

You can also click the Create button to launch the output wizard. This wizard will let you 
create custom outputs for a wide variety of applications. The available custom outputs are 
shown below. 

Figure 50.  Custom Output Wizard 

Web Produce media files for Internet delivery. 

Device Produce media files for delivery to mobile devices. 

Live Create streams for live broadcasts. Broadcasts can be archived for 
later viewing. 

High-Quality Archive Capture archive-quality recordings. The High-Quality Archive 
output files can be used with many non-linear editors. 
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Optical Character Recognition

Enabling OCR (Optical Character Recognition) allows you to translate scanned images of 
handwritten, typewritten or printed text into machine-encoded text. OCR systems require 
calibration to read a text.

OCR is most effective using large, black text on a white background. OCR sensitivity will 
largely depend on the amount of change that occurs between slides. You should test the OCR 
output with the medium you will be capturing (e.g. PowerPoint or a document camera) and 
adjust the OCR settings accordingly. For example, the following recommendations are for 
PowerPoint slides:

Creating a Mix 
This topic explains how to create and deliver an RMS presentation. RMS creates live video 
presentations sourced from VBrick Windows Media or H.264 encoders. After all inputs have 
been selected and outputs have been created, you can prepare your recording in Rich Media 
Studio's console interface.

A/V Equipment Output audio and video to external equipment such as PA systems, 
displays and projectors. This output type does not create media files.

More Produce output for specific cases such as image only, audio only, or 
less frequently used codecs. 

Background color light (e.g. white or light grey)

Text color black

Text font size 32 pt

Title font size 44 – 46 pt

Sensitivity  0.2
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Creating an Output

Follow the steps below to define the different outputs as you wish them to appear in the 
presentation.

Windows Media WM presentations are pulled by a reflector or server or pushed to a 
reflector or server (see Configuring for Pull or Configuring for Push for 
more details).

H.264 H.264 presentations are typically streams to VEMS. 

Note If you will be creating a presentation that will be saved and hosted on the VEMS 
Portal Server, see "Authoring RMS Presentations" in the Portal Server User Guide.

1. Start by connecting your audio 
and video inputs as described 
earlier and launch the 
application.

2. The available Video Inputs and 
Audio Inputs are shown on the 
left. In this example there are 
three video inputs and two audio 
inputs.

3. Select an empty output in the 
Outputs column and drag it into 
the Video Mix pane. This will 
ensure that the Video Mix pane 
has the right aspect ratio. 

4. The Video Mix pane is where 
you will arrange, scale, and 
modify the settings for the video 
layout of each output.
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5. Drag and drop a Video Input 
into the Video Mix window.

6. To scale the video input up or 
down, use the scroll (wheel) 
button on your mouse.

7. To move the video around in the 
window, right-click and drag the 
image.

8. After resizing and positioning 
the image, drag and drop the 
Video Mix you want to present 
or record into the Outputs 
window. 

9. You have now created an output 
mix that can be associated with a 
preset or saved as a template. 
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Figure 51.  Basic Steps for Creating an Output

Adjusting Settings and Mix Templates

Selected Input Settings

To configure your input, you can also use the Selected Input Settings section. This section 
allows you to make changes to the input:

• Size

10. Adjust the audio mix as 
necessary. Then drag and drop 
the Audio Mix to the output by 
dragging the Master VU meter 
from the Audio Mix window into 
the VU meter for the 
appropriate output. 

11. Each output can have a different 
audio mix. 

12. The last thing to do is to create a 
preset. Start by clicking the 
Preset button in the lower right 
corner of the application and 
entering a name for the Preset in 
the popup.

13. Then drag the output window to 
the preset. This will associate the 
output window "view" with the 
named preset.

14. When done, repeat all of these 
steps for each output type you 
wish to configure.
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• Position
• Transparency
• Brightness and Contrast
• Border width and color

Figure 52.  Selected Input Settings 

Table 9.  Selected Input Settings

Image Title Description

Horizontal Offset Sets the horizontal offset from the center of the video mix 
(Range: -5.0000 – 5.0000) 

Vertical Offset Defines the vertical offset from the center of the video mix 
(Range: -5.0000 – 5.0000) 

Scale Sets the size of the video input as it will appear in the Video 
Mix (Range: 0.0000 – 5.0000)

Yaw Sets the yaw of the video input relative to the center of the 
video input (Range: 0.0000 – 5.0000)

Pitch Sets the pitch or vertical "tilt" of the video input relative to the 
center of the video input (Range: 0.0000 – 5.0000)

Roll Sets the roll or rotation of the video input relative to the 
center of the video input (Range: 0.0000 – 5.0000)

Alpha Sets the alpha or transparency of the video input (Range: 
0.0000 – 1.0000)

Gamma Adjusts the gamma or gray levels between black and white are 
displayed for the video input (Range: 0.0000 – 5.0000)

Brightness Adjusts the overall brightness of the video input. (Range: -
1.0000 – 1.0000)

Contrast Adjusts the overall contrast of the video input (Range: 0.0000 
– 2.0000)

Border Thickness Controls the size of the video input’s border (Range: 0.0000 – 
10.0000) 
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Mix Background Settings 

You can specify a color or import an image for the background of a mix in the Mix 
Background Settings section.

Figure 53.  Mix Background Settings

Mix Templates

After a mix is created, it can be saved as a template for future mixes.

Figure 54.  Colors Defining a Mix Template

The colors correspond to the various inputs.

Events

Professional Edition only. Events can enhance a presentation with the ability to add meaningful 
data during a recording. A presenter can create a chapter point in any part of a presentation, 
insert captions which will appear in the close captioning area of the interface, or insert search 
terms into any point in a recording allowing the user to search on a keyword to locate a 
specific portion of a presentation. A presenter can also add post-production Events to signify 
to the video editor, including specific notes for the editor as well as segments of the video to 
be removed via Rich Media Studio's Mark In/Out feature. The Events feature is only accessible 
in the Rich Media Studio console interface and appears on the right window column under 
the Events tab.

Border Color Determines the color of the selected video input’s border 
(Values: hexadecimal value or common color name. i.e. "red")

Image Title Description
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Figure 55.  Adding and Managing Events 

The following list describes each of the Events that can be added during a recording.

Table 10.  RMS Events

1. Under the Cue pane, click on an Event button (Chapter, 
Caption, Search, URL, Mark In, Mark Out, Note, Custom). 

2. Enter the appropriate text in the field provided. 
3. Specify a time for the event or click the "timer" button to set 

the current time of the recording.

4. Click on the "up" button to apply it to the time line. The Event 
should appear in the Monitor pane. 

5. To remove an event, click on the "down" button in the Monitor 
pane and it will come down into the Cue pane.

6. Click the "cancel" button to cancel the Event completely.

Chapter A Chapter can be added to specify areas in a recording a presenter may 
wish to identify as a key segment in a discussion. By adding a title, a 
chapter is created with the title the presenter has specified. Note that these 
Chapters are created in parallel with the chapters created by Rich Media 
Studio's OCR.

Example A presenter may discuss a single image at length that contains no 
recognizable text for OCR. The presenter could send Chapter events 
during the discussion of that image to create chapters so the audience can 
navigate to a specific portion of the discussion.
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Scheduler

Not available in Standard Edition. The Scheduler allows you to schedule recordings in advance. 
Scheduled recordings can be configured to repeat based on a day of the week and time. This 
is useful for recording regularly scheduled events such as classroom lectures.

Caption A Caption can be added to a recording by sending a Captions event. These 
captions appear in the closed captioning area typically occupied with 
closed captioning text that appear when the CC button in the Rich Media 
Player is pushed.

Example A presenter can take advantage of this feature by adding 
captioning notes to display to the audience. This could be useful to display 
text to highlight key concepts or to display a mathematical formula.

Search Search terms can be added to a recording to make any segment of a 
presentation searchable.

Example A presenter with a speech-only discussion will not have automatic 
chapter creation or searchable text. The presenter may wish to insert 
searchable keywords pertaining to various segments of the discussion so 
the viewer can search for that portion of the presentation.

URL A URL event can be sent during the recording if a presenter wishes to add 
a URL as a resource during a presentation.

Example A presenter may have a web resource available not available in a 
presentation slide. To make this URL available to the viewer, the presenter 
can send a URL Event to provide a link of the online resource to the 
viewer.

Mark In | 
Mark Out

The Mark In and Mark Out events are used for post production of a 
recording. Sending these events during a recording will mark the timeline 
with "In" and "Out." If the presentation requires editing, an editor can 
view the timeline for these In and Out marks and remove portions of the 
video accordingly.

Example A presenter may discuss a topic outside the course curriculum 
and may elect to remove that segment of the recording. For this situation, 
the presenter can send a Mark In event, marking the beginning of the 
section to be removed. The presenter can then send a Mark Out event to 
mark the end of the section to be removed, after which the presenter can 
continue with regular course discussion.

Note The Note event is used to provide notes for a video editor for post 
production of a recording if any is required.

Example The presenter can send a Note event during a recording which 
signifies to the editor about a particular portion of the video.

Custom The Custom event is a free field used to add any custom information to a 
presentation.

Example Some organizations may require recordings to be categorized or 
grouped. The Custom Event can send any text to identify a recording as 
belonging to a particular group.
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Figure 56.  Scheduler

 To create a new scheduled recording: 

1. From the Scheduler dialog, click the Create button to launch the Scheduler Task Editor. 
2. In the Scheduler Task Editor, enter a Name for the scheduled recording.
3. Select the appropriate Session File for the scheduled recording.
4. Specify the Start Date/Time for when the recording is to start. A calendar will appear 

when you click on the white arrow next to the Date field for easy date selection.
5. Specify the Duration for which the recording should last in hh:mm:ss format.
6. Check the Repeat checkbox if the recording is to occur regularly.
7. If Repeat is checked, specify which Days of the week the recording should occur.
8. For repeating recordings, specify the Expire Date for the recording. The Expire Date is 

the date after which the recording will no longer occur and will be removed from the 
Scheduler.

9. Enter the password for the Windows user account that is scheduling the recording. The 
Windows user name appears in the user box above the Password field.

Changing the Language
The RMS software is available in English, Spanish, French and Japanese. If want to use RMS 
in a language other than English, you must change the language in Windows on the Control 
Panel > Regional and Language Options page. If you do not, the OCR (Optical Characters 
Recognition) functionality will be available only in English. You will also will need to set the 
language for all outputs with Audio Stream in the output options window. By default, the 
language is set en-us. 

Notes • Only a user with Administrative privileges can access the scheduling features.
• Scheduling a recording requires a password. If a user account is created under 

which scheduled recordings will run, a password is required for that user. the 
scheduler will not work on a profile (Administrator/User) without a password.

• Scheduled tasks will only run on the Windows account that created the scheduled 
recording. If recordings were scheduled under the Administrator account, you must 
be logged into the Administrator account for those recordings to run.

• When scheduling a recording, be sure that the recording does not overlap a 
previously scheduled recording.
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Saving a Session 
When working in a session, click the OK button when navigating through different pages to 
temporarily save your changes. To permanently save the session, go to File > Save Session As. 
This will overwrite the template associated with that session and is not recommended. An 
alternate method is to use the Output Editor page shown below to create a Profile. A profile 
is an .xml file that is a subset of a session template. You can load or save a profile using the 
icon on the right side of the pane. If you create a "profile" of your session changes, you will 
not need to overwrite the template. Profiles are saved as .xml files in 
C:\Users\RMS\Documents
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Chapter 6

Viewing Rich Media Streams
Topics in this chapter

Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65
Viewing Live Streams. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65
Viewing Stored Streams . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66

Overview 
RMS presentations are typically delivered as live streams and they can also be recorded and 
saved as stored (VOD) files. Live streams can be played and viewed directly from the RMS or 
from VEMS (if a VBrick Portal Server is present). From VEMS, live or stored streams can be 
viewed using a Portal Server desktop client and/or the stream can be sent to local set top 
boxes. Stored streams can be played from a Windows Media Server (.wmv files) or a Darwin 
server (.mp4 files), or they can be played from VEMS. Stored streams cannot be played 
directly from the RMS. 

Viewing Live Streams

Viewing Live Streams from RMS

Live RMS presentations are typically streamed live and can be viewed on individual desktop 
players. RMS outputs Windows Media streams and H.264 streams. Windows Media streams 
are typically played in a Microsoft Windows Media Player (by pointing to a VBrick Windows 
Media Reflector or to a Windows Media server). H.264 streams are usually played in 
StreamPlayer, Quicktime, or VLC (by pointing to a Darwin server or a VBrick DME). In 
both cases the RMS streams can be configured for "push" or "pull" as appropriate. 

Viewing Live Streams from VEMS 

There are two basic ways to view live RMS streams in VEMS: 

• By viewing a live VEMS presentation (created with the VEMS Presentation tool) to 
which you have been invited. VEMS presentations are interactive and you can ask 
questions, respond to polls, and view reference material. In this scenario the presentation 
is authored in VEMS and in RMS and is shown on the Live Media page in VEMS. This 
scenario is described in detail in the "Authoring RMS Presentations" topic in the Portal 
Server User Guide. 

• By viewing a live stream from VEMS (v5.4 or higher) which has been (1) configured in 
VEMS as a URL for a live video stream or (2) has been auto-discovered by a SAP 
announcement from RMS (H.264 streams only). In this scenario the stream is not 
interactive and all you can do is watch.

../PDF_Files/PortalServer_UserGuide.pdf
../PDF_Files/PortalServer_UserGuide.pdf
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Viewing Stored Streams
Stored streams can be archived on the RMS machine but they cannot be played and viewed 
directly from RMS. You will need to use one of the following methods to view stored RMS 
streams.

Viewing Stored Streams from a Server 

• Windows Media files can be FTPed to a Windows Media Server and played using a 
properly formatted URL. 

• H.264 files can be FTPed to a Darwin server or a VBrick DME (which acts as a VOD 
server) and played using a properly formatted URL. 

Viewing Stored Streams from VEMS

There are two basic ways to view stored RMS files in VEMS:

• By viewing a stored VEMS presentation (created with the VEMS Presentation tool) 
which has been FTPed from RMS and published to the Media Library in VEMS. This is 
the only way to make stored Silverlight presentations available in VEMS. See the "Authoring 
RMS Presentations" topic in the Portal Server User Guide for more information. 

• By opening a VEMS client on the RMS machine and using the VEMS "Add Video" 
feature to copy files to a VEMS VOD server.

../PDF_Files/PortalServer_UserGuide.pdf
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Chapter 7

Maintenance and Upgrade
Topics in this chapter

System Maintenance. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67
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Software Upgrade. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68

System Maintenance

Installing Windows Updates

The Rich Media appliance shipped with "Automatic Updates" for Windows set to Notify me 
but don't automatically download them. To avoid impacting performance, install updates only 
when the system is idle. Also, be sure to install "high" and "critical" updates only. Do not 
update any drivers except as directed by VBrick. 

Managing Disk Space

All Studio Touch templates are configured to record each presentation, and since the Rich 
Media Studio is configured with a 500 GB hard drive, you will need to manage disk resources 
accordingly. There will be no indication that the drive is getting full. However if the computer 
performance is noticeably slower or common tasks like deleting files take longer than usual, 
you may want to check the disk. If you have less than 25 GB of Free space remaining, you 
should probably move some recorded presentations to another location or server. 

 To view available disk space 

1. Open Windows Explorer and click on My Computer.
2. Right-click on the C: drive and select Properties. 

Backup and Restore
IMPORTANT This section explains how to restore the Rich Media Studio to its original 
settings using the Acronis system restore image that was installed prior to shipment. Before 
performing a restore, please save all relevant data (such as session templates and archives) 
and be sure you have the Windows Operating System (located on a sticker attached to the 
bottom of the unit). If you cannot find the Windows Operating System key, please contact 
VBrick Support Services before proceeding. 

 To restore the Rich Media Studio:

1. Reboot the Rich Media Studio appliance.
2. At boot up, press F11 once when the message "Starting Acronis Loader... Press F11 to 

..." is displayed. 

Note Be aware that the RMS application requires a dedicated platform. Do not install anti-
virus or other software on the RMS computer. 
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3. Verify that the Acronis software page actually loads. If it does not, reboot the appliance 
and start again.

4. On the Acronis software page, select Restore and follow the instructions. 
5. After completion of the restoration process, the system should reboot and enter the 

Windows mini-setup (default values may apply). You will need to enter the Windows OS 
key when prompted. 

6. After completion of the mini-setup, you will be able to login. You may need to activate 
the Windows Operating System key by calling Microsoft since it needs to be reactivated 
(activation by phone option).

7. Perform Windows updates (see above Installing Windows Updates) and apply any 
relevant VBrick software upgrade. 

Software Upgrade
The following procedures explain how to upgrade RMS versions 1.0/1.2/1.3 to RMS 1.7.27. 
Be aware that RMS Professional Edition and High Definition have support for additional 
audio and video inputs (see Rich Media Studio Versions on page 5). When creating inputs 
and outputs, use default.session for RMS v1.0 or v1.2 units. Use defaultHD.session for 
RMS 1.3/1.7.x units. Be sure to save all .session files before an upgrade. Be sure to replace 
any .sdp files on web servers (e.g. VEMS, DME) after an upgrade. As shown in Table 11 
there are multiple components (in addition to the 1.7.27 application software) required for 
this upgrade. These upgrade components are bundled into a zip file and can be downloaded 
from www.vbrick.com/support/downloads.asp You will need to download this zip file before you 
begin the upgrade. 

Table 11.  Contents of RMS_1.7.27_Upgrade.zip

Upgrading from RMS 1.0/1.2/1.3 to 1.7.27

 To upgrade your existing RMS 1.0/1.2/1.3 software to RMS v1.7.27:

1. Install any high priority Windows updates. 
2. Reboot. 
3. Download all required files from the VBrick website as explained above. 
4. On Windows 2008 or Windows 7 (not Windows 2003): 

a. Launch a Command Prompt window. 
b. Enter the following command: bcdedit /set increaseuserva 2304 

5. Uninstall existing 1.0/1.2/1.3 software from your system completely using Windows 
Programs and Features. 

6. Launch the Videum drivers installer (WnvAvs_3_6_866_usa_QA.exe) and follow the 
prompts using the defaults. Be sure to select Reboot before install. 

Software File Name Description

Application Software VBrick_RMS_1.7.x.msi Application software for version 1.7.x

Session Configurations default_v1.7.x.zip This folder has the default session 
templates.

Players Actions_v1.7.x.zip These software components are 
required for all installations.

Videum Drivers WnvAvs_3_6_866_usa_QA.exe This folder has the hardware drivers.

http://www.vbrick.com/support/downloads.asp
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7. Reboot. 
8. Complete the installation. Proceed through the dialogs using the defaults.
9. Reboot/shutdown may be required.
10. Launch the 1.7.x installer (VBrick_RMS_1.7.x.msi) and proceed through the dialogs.
11. Windows 2003 go to: C:\Documents and Settings\All Users\Application Data 
12. Windows 2008 or Windows 7 go to: C:\ProgramData 
13. Go to the installation folder folder. 
14. Unzip the Actions/Players file (Actions_v1.7.x.zip) and copy the content into the 

Actions folder. 
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MicroTouch Software Overview
The 3M MicroTouch MT 7 software (available on RMS HD Portable systems only) allows 
users to select, launch, and drag objects using the sensor. MT 7 provides support for 
MicroTouch sensor operation for all RMS operations. You can use the MT 7 control panel to 
set your preferences for the sensor. For example, you can define the following preferences:

• Whether the touch action occurs when you touch the sensor or when you lift your finger 
(or stylus) off the sensor.

• Whether you hear a sound when you touch the sensor.
• Define a frame around the active touch area in which the cursor moves closer to the 

edges of the sensor.
• You can also use the MT 7 control panel to calibrate the touch sensor and run optional 

programs. The Calibration Tool enables you to calibrate your touch sensor without 
launching the control panel.

MicroTouch Control Panel
The MT 7 software control panel consists of tabs that allow you to determine the best 
settings for your touch system configuration.

• Use the Main tab to run a three-point calibration routine for optimum accuracy of your 
sensor.

• Use the Touch Settings tab to define the touch actions that equate to mouse actions and 
add right-click functionality to the touch sensor.

• Use the Edge Adjustment tab to define a frame around the active touch area in which the 
cursor moves closer to the edges of the sensor.

• Use the Tools tab to restore hardware or software defaults, reset controller, run Draw 
Test from the desktop, and to enable Advanced Options for your touch sensor.

 To open the MT 7 control panel:

1. Go to Start > All Programs > MicroTouch MT 7 > Control Panel. 

Note The 3M™ MicroTouch™ MT 7 software is available on RMS High Definition 
(Portable) systems only.
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Calibration

The calibration process aligns the sensor with the underlying video. Specifically, calibration 
defines the dimensions of the active area of the sensor and locates the center of the sensor. If 
the sensor is not calibrated, the active area of the sensor may not be aligned properly or may 
be unnecessarily small. You should calibrate the sensor in the following cases:

• Any time you change the size and position of the video image by adjusting the horizontal 
and vertical controls on your display.

• Any time the cursor does not follow the movement of your finger, or does not reach the 
edges of the sensor. If you continue to need additional accuracy along the edges, use the 
Edge Adjustment tab.

 To calibrate the sensor:

1. Select the Main tab.
2. Click the Calibrate button.
3. A calibration target appears in the lower left corner of the sensor.

4. Touch the sensor positioning your fingertip to completely cover the green target. This 
position is calculated upon liftoff and when you remove your finger, the target should 
turn red. When touching the calibration target, make sure to:
a. Face the display directly.
b. Perform the calibration in the position (sitting or standing) you expect to normally 

use the sensor.
c. Touch the calibration target firmly and precisely with your fingertip. During 

Calibration, be careful to keep your fingernails and other fingers away from the 
sensor as you touch the target.

5. Repeat these instructions for additional calibration targets.

Note  If you press Esc or do not touch the sensor within twenty seconds, the system 
automatically cancels the calibration process with no change to the current settings.
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6. Once you have calibrated the sensor, a dialog box will appear to ask if you wish to test, 
accept or cancel this calibration.

Testing the Calibration

If you accidentally liftoff from the sensor in the wrong place during calibration, you will 
distort the sensor calibration. Test by touching several points on the sensor to make sure you 
are satisfied with the calibration results. The cursor should be located underneath your finger 
or pen when you touch the sensor. Repeat the Calibration process until you are satisfied. 
Recalibrate the sensor if any of the following tests fail. Touch random points on the sensor. 
The cursor should be located underneath your finger or pen when you touch the sensor.

1. Drag your finger across the sensor and check that the cursor follows your movements.
2. Touch each corner and along the edges of the sensor. Verify that the cursor reaches the 

full image area of the sensor. Be sure you can touch and activate all icons and menus 
across the entire sensor.

3. If you are using a pen stylus, be sure to perform the calibration procedure using the pen.
4. If you need to recalibrate the sensor, make sure to touch the targets carefully. It is 

possible that one of your touches did not register properly or you accidentally touched 
the sensor in the wrong place during calibration. For example, if you touch beyond the 
targets or into the non-image area, you will distort the sensor calibration.

Touch Settings 
The Touch Settings tab enables you to customize the response of your sensor. You can 
change the way the system responds to your touch, add a right-click tool to your desktop, tell 
your system to beep on touch, and define the double-click speed and area of your touch.

Touchdown Mode

Touchdown Mode enables you to create an immediate button action as soon as you touch the 
sensor. In Touchdown Mode, you cause a button down at the cursor location, with a
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short pause and then a button up. You can leave your finger on the sensor but only a single 
touch is registered until you lift your finger off the sensor and touch down again. Touching 
the sensor is equivalent to pressing and releasing the mouse button. The action occurs as 
soon as you touch the sensor. This mode is best for button-based applications (like a 
calculator). Drawing or dragging is not supported in this mode.

Liftoff Mode

Liftoff Mode enables you to position the cursor where you want before creating a button 
action. In Liftoff Mode, the cursor will follow your finger for a more accurate touch. When 
you want to select an item, lifting your finger off the sensor will cause a button down, short 
pause, and then a button up to occur. Touching the sensor is equivalent to moving the mouse 
position. The button down/button up action occurs when you remove your finger from the 
sensor. This mode is useful for applications requiring greater accuracy because it lets you 
carefully position the cursor before acting on it. Drawing or dragging is not supported in this 
mode.

Right-Click Tool 

This option places an icon on the desktop (always on top of your application) that allows you 
to select which mouse button to activate on touch. This icon can be dragged anywhere on the 
screen. In the image you will see that either the right-click or left-click mouse button is green. 
This is the active button. Note that this works for the next click action only. After you have 
selected the right-click option and then touched the screen causing the right-click menu to 
appear, the mouse will automatically revert back to its original left-click state. You can 
position this icon anywhere on your desktop by selecting it, pausing until the four-pointed 
arrow appears, and dragging it wherever you want. Left button is typically used for normal 
select and normal drag. Right button is typically used for applet properties such as context 
menu and special drag. For Windows 7 (when used with the touch digitizer option) press and 
hold your finger down on the screen. A ring will appear around the point at which you are 
touching and upon liftoff the right-click menu will appear.

Touch Sound

Select audible beep on touchdown, liftoff, or no beep at all. Click on the Beep button to 
select the appropriate option for your application. The default setting is no beep on touch 
(Beep off).

Double-Click Speed 

Double-click speed defines how quickly you must touch the sensor for the system to 
interpret your actions as a double-click. Set the double-click speed in the slow to medium 
range for optimum performance with a touch sensor. Touch the globe twice to test the 
double-click speed and area settings. If the globe begins to spin, the sensor recognized your 
touch as a double-click. Note: Changing this setting will affect the double-click setting of the 
mouse.

Double-Click Area 

Double-click area defines the space in which you must touch the sensor for the system to 
interpret your actions as a double-click. Set the double-click area in the medium to high range 
for optimum performance with a sensor. Touch the globe twice to test the double-click speed 
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and area settings. If the globe begins to spin, the sensor recognized your touch as a double-
click. Note: Changing this setting will affect the double-click setting of the mouse.

Edge Adjustment Tab
Once you calibrate the sensor, the cursor should be located directly beneath your finger when 
you touch the sensor. However, this may make it difficult to touch items at the very edges of 
the sensor. The Edge Adjustment tab enables you to define an offset area in which the cursor 
moves closer to the edges of the sensor so you can easily and more precisely select small 
items, such as single words, the Windows Start button, check boxes, or radio buttons. For 
example, if you have a row of buttons along the left edge of your sensor, you may want to set 
an edge adjustment to enable users to easily activate these buttons. Because each edge is 
independent of the other, you only need to adjust the left margin to accommodate this row of 
buttons.

To set the Edge Adjustment, move the sliders inward to define the offset area. These changes 
take effect immediately. Click Test to preview your choices. The area you have defined 
appears as a colored area as shown below. Within this colored area, the cursor will 
automatically move ahead of your finger so you can more easily touch items closer to the 
edge. Determine if the area you have defined is sufficient for your needs. Can you touch into 
the corners and along the edges of the sensor? Click Esc, End Test, or Return to go back to 
the Edge Adjustment tab. If you are satisfied with the selections you have made you are done. 
If not, adjust the sliders to better accommodate your needs.

Troubleshooting

Cursor Does Not Reach Edges of Display

Try calibrating the touch sensor. When calibrating the sensor, be sure you touch the center 
of each target firmly and precisely. If additional tuning is necessary, use the Edge 
Adjustment Tab to enable greater ability to touch into corners and edges of the sensor.
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Cursor is Jittery

You need to adjust the Sensor Frequency. Choose Sensor Frequency from the Controller 
tab. Any time you adjust the frequency you should test how the sensor is working and verify 
you are satisfied with the operation of the sensor.

Cursor Jumps or Bounces Suddenly Across the Display

You are most likely touching the sensor in more than one spot at the same time. Be sure to 
point and touch with one finger only. Keep your other fingers away from the touch sensor. 
Do not rest your other hand on the display or bezel at the same time.

Double-Click Doesn't Work

Use the Touch Settings tab to adjust the double-click speed and area. The double-click speed 
defines how quickly you must touch the sensor for the system to interpret your actions as a 
double-click. Set the double-click speed in the slow to medium range for optimum 
performance with a sensor. The double-click area defines the space in which you must 
touch the sensor for the system to interpret your actions as a double-click. Set the double-
click area in the medium to high range for optimum performance with a sensor. Click on 
the globe to test the double-click speed and area settings. If globe begins to spin, the sensor 
recognized your touch as a double-click. Note: Changing this setting will affect the double-
click setting of the mouse.
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Chapter 9

Streaming to the DME
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Streaming to the DME with RTP Auto-Unicast
This topic explains how to configure an RMS-to-DME stream using RTP Auto-Unicast push. 
This interface is more stable and user-friendly than the previous RMS-to-DME interface. 

 To configure an RTP Auto-Unicast stream to a DME:

1. Open RMS and enter a destination address on the Broadcast page. In the Destination 
Address field (Figure 35) enter the unicast IP address of the DME.

2. Change the source port to a legal port number that is unused on the source RMS.

Figure 57.  RMS Broadcast Options (Part 1)

Note When entering metadata (e.g. Session Info, Origin E-Mail, etc.) be sure to remove any 
leading spaces.
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Figure 58.  RMS Broadcast Options (Part 2)

3. Enter the DME IP Address as the RTSP Address. Enter the DME Auto Unicast 
destination port as the RTSP port. You can indicate use of the Auto Unicast listener on 
either the RTP server or the Multi Protocol server by designating the appropriate DME 
port. The Multi Protocol server is recommended. If password security is enabled the 
RTSP Username and Password must be entered. Enter an SDP File Name. This name will 
be the stream name for stream redistribution.

4. After starting the session, a live RTP stream will be available in the DME that can be 
served in a number of ways (see Figure 37). For example, you can reflect the stream as a 
multicast relay or auto-unicast it to another DME.

Figure 59.  RMS/DME Integration

Playback Examples

VEMS Mystro (Live 
Entered URL)

vbrtsp://172.1.1.1/vbStream1S1 
vbhttp://172.1.1.1/vbStream1T1.sdp 
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Streaming to the DME with RTMP Push
This topic explains how to configure an RMS-to-DME stream using an RTMP Push output. 
This is an alternate improved interface (that requires DME 3.1.1 or higher). 

 To configure an RTMP Push to a DME:

1. Go to the Session Properties page and then click Outputs and Create. 
2. Click on the Live icon, highlight H.264 for Flash, and click Next. 
3. Click on the Options button, scroll down to Broadcast (RTMP), and expand the pane.

4. Configure the URL, Stream name, and credentials as follows:

5. When done click OK and Finish and the H.264 for Flash option will be added to the 
Outputs menu as a selectable output option.

iOS http://<dme_ip_address>/HLS/<stream_name>/playlist.m3u8 

URL DME IP address in this format: rtmp://<DME_IP_Addr>:1935/live 

Stream User configurable stream name that will be shown on Monitor > 
Multi Protocol Connections page and used in a Flash player. 

Username    DME user name from User Configuration > Stream Input Authentication 
page. 

Password DME user name from User Configuration > Stream Input Authentication 
page. 
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